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Copyrights and Trademarks
Program© 1996 Expert Software, Inc. Clip Art Images © 1996 by Imageline, Inc.
Portions © 1996 Imspace Systems, Corporation. Font production by SWFTE,
International. Documentation © 1996 Expert Software, Inc. All Rights Reserved.
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and Microsoft are registered trademarks of Microsoft Corp. All other Trademarks are
acknowledged.
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Usage Rights and Restrictions
You may:

Copy the CDs on one computer hard drive and use the images on that computer.

Use, copy, modify and publish any of the digitized images contained in the program
for use in advertisements, newsletters, public, private and business presentations,
and other uses, provided the actual images are not being sold. For example, you can
use the image(s) as an embedded image(s) in the program such as a background
screen, but not as a program file, such as a .PCX or other pic-
ture format.

Use the images to create calendars, greeting cards, posters or
other items which are not intended for sale.

Use the images as part of a software product, provided the user
does not have access to the actual image files.

Use the images to create calendars, greeting cards, posters or
other items which are intended for sale. For example, if you cre-
ate a sports calendar using images found in the photo CD and
intend to distribute and sell these calendars, this is a violation of
the license agreement.
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Usage Rights and Restrictions (Cont’d)
You may not:

Make copies, film negatives or positives, magnetic copies of the
images of the CDs for sale, rental, lease, or transfer to another per-
son or entity, other than the permitted user.

Distribute any of the images as part of any software product(s), in
electronic file formats such as .PCX, .TIFF, .BMP, etc.

Copy the program(s), alter, modify or adapt them.

Copy, decompile, disassemble, modify, translate or create derivative programs based
on the applications embedded in the program(s).

Use or alter, in whole or in part, a digitized image in any manner for pornographic
use.
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Additional Information
The following categories are listed in the Kudo Browser:

• Borders
• Calendar
• Cards
• Corners
• Events
• Family
• Holiday
• Leisure
• Misc.
• Objects
• Ocassion
• Tags

Expert Software recommends that the .WMF format is utilized for clearer resolu-
tion and optimal resizing capabilities. To use the .WMF images, go to the d:\con-
tent\.wmf directory (where d:\ is the drive letter of your CD-ROM).

Note: you must have a .WMF filter or an application that is able to open a .WMF
format file to view these images.
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1
Program Overview

Learn registration procedures, installation
instructions, and how to get started using
Kudo Catalog Reader.

Welcome to Expert’s Image Collection!
This collection contains numerous images which can be used in a variety of docu-
ments. This online manual contains instructions for using the images in a variety of
programs as well as how to use the Kudo Catalog Reader to print and preview the
images before placing them into a document. This chapter covers registration pro-
cedures, installation instructions, and how to get started using the Kudo Catalog
Reader.
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Registration
By registering, Expert Software, Inc. can keep you informed of the latest changes
and improvements to this product, as well as information on our other products.
Sending in your registration card also allows you to receive free product support.

In order to register this product, you must first run the Expert Setup program.

For Windows ® 95 users:

1. Insert the Expert CD into your CD-ROM drive. From the Taskbar, click on the
Start button. Point to and click on the Run command.

2. Type d:\expert\setup (where d:\ is the letter of your CD-ROM drive) and then
click on the OK button.

3. Follow the prompts to complete the installation. Fill out, print and send the
online registration card to Expert Software, Inc.
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For Windows ® 3.1 users:

1. Insert the Expert CD into your CD-ROM drive. From Program Manager, choose
File–Run .

2. Type d:\expert\setup (where d:\ is the letter of your CD-ROM drive) and then
click on the OK button.

3. Follow the prompts to complete the installation. Fill out, print and send the
online registration card to Expert Software, Inc.

Mail to: Expert Software, Inc.
P.O. Box 144506
Coral Gables, FL 33114-9796

Fax it to: (305) 569-1350
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Starting the Online Catalog
When you register the program, the Online Catalog will be installed. To access the
Online Catalog which allows you to preview other exciting Expert products:

Windows ® 95 users

Insert the Expert CD into your CD-ROM drive. On the Taskbar, click on the Start
button, point to the Programs folder and the Expert Software folder and finally,
point to and click on Expert Online Catalog .

Windows ® 3.1 users

Insert the Expert CD into your CD-ROM drive. Locate the Expert Software pro-
gram group and maximize or double-click on the Expert Software icon. Once it
opens, double-click on the Expert Online Catalog icon.
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Installing TrueType Fonts in Microsoft® Windows®

1. Place the Expert CD into your CD-ROM drive. From Microsoft® Windows®

Program Manager, double-click on the Holiday Clip Art Fonts icon located in the
Expert Software program group. The Fonts dialog box will appear.
2. Click on the drop-down list box and select a Font family. All the fonts for that
family are displayed in the larger box.
3. After highlighting
the desired fonts,
click on the Install
Selected Fonts but-
ton.
4. To make multiple
font selections, press
the CTRL key while
you click on the
desired fonts.
5. After installing the
desired fonts, this
window appears to
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confirm your selection. Click
on the OK button.

Note: it is recommended that you do not have more than 20 fonts installed on your
system at one time. For Win 95 users, after installing the fonts, click on the Fonts
icon in the Control Panel to update the fonts folder. All fonts will be visible in the
application.

Installing TrueType Fonts in Macintosh®

1. Quit all running applications
2. Insert the CD into the CD-ROM drive.
3. Double-click on the MAC TrueType® Folder.
4 Shift-click on each desired font and drag it onto the Systems/Fonts Folder.

Please note: all other commands are identical for Macintosh and Windows users.
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Terminology used in this manual
Please note, Note, Hint, or Tip: Additional or background information on a com-
mand or procedure.

Choose File—Open : Choose a command from the applicable menu item. In this
case, the command means to go to the File menu and select the Open command.

1, 2, 3, etc. : Sequential steps that are numbered in order of execution. Start with
step 1 and proceed through the next step in order to complete the procedure
being described.

Drag & Drop : Press and hold the mouse button, then drag or move the mouse.
Release the button when the movement is finished.

Control Menu Box : The hyphen-shaped icon is located in the upper left corner of
dialog boxes and windows. By double-clicking on the icon, you will close the cur-
rent application. This functions as if you had pressed the ALT key and the F4 key
at the same time.
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Using Kudo Catalog Reader
The Kudo Catalog Reader enables you to open catalogs of images in various dis-
tinct categories. Each category is a separate catalog. The Kudo Image Browser
catalogs the image files using thumbnails. Think of a thumbnail as a miniature
photo of the image file. It looks like the file, but it's a replica that takes up very little
memory. Kudo uses the thumbnail in its catalog and leaves the image file
untouched in its original form and location. With these compact thumbnails, Kudo
catalogs the image files in a convenient, accessible way.

The thumbnails provide a visual reference for each image file. Kudo adds informa-
tion, such as the original file’s name, location, size and file type to complete the
catalog.

The Kudo Catalog Reader Window

Kudo allows you to view image thumbnails in three ways: gallery, small gallery,
and list views. This is a typical Kudo Catalog Reader window. The catalog selected
is being displayed in the Gallery View.
Please note: the Kudo Catalog Reader displayed is an example and may not
reflect your onscreen images or the categories available on your CD-ROM.
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1. Small Gallery View Button - The Small Gallery View uses the same layout as
Gallery, but with much smaller images. This allows the user to view more
images at once.

2. Gallery View Button - The Gallery View uses a grid-style layout showing sever-
al thumbnails and their file type and size at once. Click on the Info button to
view more detail about the selected thumbnail.

3. List View Button - List View uses a vertical layout with fewer thumbnails in the
window, but with a notes section for each file. The List View displays the thumb-
nails in a vertical column and the blank notes section in a second vertical col-
umn.

4. Find Button - Use the Find feature to search the catalog for thumbnails with
specific characteristics. Kudo searches the catalog and displays the thumbnails
that were identified in the search. All other thumbnails are hidden from view.

5. Info Button - The Info button gives you quick access to a thumbnail's informa-
tion. This option tells you the filename, volume, size, date, location of file and
any notes attached to the thumbnail. Note: the date, volume and notes will
most likely contain the same information for all images. Also, the notes section
is blank for the images in the catalog.
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6. Menu Bar - The menu commands allow you to access all the main program
features.

7.Thumbnail - A thumbnail is a small picture of your original file. Thumbnails
allow you to preview your image before selecting it. Select a thumbnail by click-
ing on it once.

To open a full-screen preview of the image, choose Image—Display Original.
To open the thumbnail into a Paint program such as Microsoft Paint, double-
click on the thumbnail. Note: this will only work if the thumbnail image format
(.BMP, .PCX, .TIFF, .WMF, etc.) has been associated with the Paint program
application.

8. Image Information - This area displays the file name and size of the original
image. Note: this area is only visible in the Gallery View.

9. Riffle Feature - The Riffle feature displays the selected catalog's thumbnails
one at a time in the lower right corner of the main window.
To control the Riffle speed and direction, hold down the left mouse button and
drag the control bar from the center to the left or right of the Riffle Control. Kudo
advances through the catalog until you release the control or until it reaches
either end of the catalog.
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When the mouse button is released or the control bar is returned to the center
position, Kudo stops near the thumbnail that you choose and displays the sur-
rounding thumbnails.Your reactions may be slower than Kudo's Riffle feature,
so when you release the Riffle control, you may have to select a thumbnail that
is a few frames ahead of the one you want.

10. Status Bar - The Status Bar displays the number of thumbnails currently dis-
played out of the total number of thumbnails contained in the active catalog.
For example, the active catalog contains 13 thumbnails which is displayed as
"13 of 13 found." After executing the Find feature for all images whose name
contains the letter "B" for example, only 3 thumbnails meet the search criteria.
The Kudo Browser window only displays the 3 found thumbnails and the
Status Bar displays "3 of 13 found."

Use either the Find All option from the Image menu or find "Everything" using
the Find button.

Please note: the “Read Only” message on the status bar indicates that the
images in the catalog cannot be modified.
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Tools/Toolbars

This chapter details the tools accessed
from the Kudo Catalog Reader’s toolbar.

Small Gallery View button
The Small Gallery View uses the same layout as Gallery, but with much smaller
images, allowing the user to view more images at once. The filename is not dis-
played in this view. Click on the Info button to view detail about the selected
thumbnail. This command can be activated by choosing View—Small Gallery .

2
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Gallery View button
The Gallery View uses a grid-style layout showing several thumbnails and their file
type and size at once. Click on the Info button to view detail about the selected
thumbnail. This command can also be activated by choosing View—Gallery .

List View button
List View uses a vertical layout with fewer thumbnails in the window than the
Gallery View and a blank notes section. The List View shows the thumbnails in the
first vertical column and the blank notes section in a second vertical column.
Simply click on one of the three View buttons to toggle to the view desired. This
command can also be activated by choosing View—List .

Please note: the information in the List View cannot be edited because the infor-
mation resides on the CD not on your hard drive. In other words, the catalog is
Read Only.
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Find button
Use the Find feature to search the catalog for thumbnails with specific characteris-
tics. Kudo searches the catalog and displays the thumbnails that were identified in
the search. All other thumbnails are hidden from view. When you click on the Find
button (or choose Image—Find), Kudo displays the Find Image dialog box.

1. Use the first combo box to tell Kudo which thumbnail characteristic it should
search.You can search by name, size, date modified, notes or location. Note:
images in a catalog only have a distinct name and size, all other characteristics
are the same.
2. Use the next combo box to tell Kudo how to search the catalog. The selections
in this combo box will appear after you make a selection in the first combo box.
3. The Edit Text box tells Kudo what words or information to search for. Wild Card
characters such as * or ? are not necessary. Enter or type text into this box.
4. Click on the Find button. Note: when you exit from the catalog and reopen it, all
images in the catalog will be found.
Note: To revert to all images in the category, choose Image—Find All .
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Info button
The Info button gives you quick access to a thumbnail's information. This option
tells you the filename, volume, size, date, location of file and any notes attached to
the thumbnail.

Note: The date, volume and notes may contain the same information for all
images. The notes section may also be blank.

To display a thumbnail's information:

1. Highlight a thumbnail by clicking on it.
2. Click on the Info button.
3. Kudo displays the information in a floating window called Image Information.
4. To close the window, double-click on the Control Menu box (the hyphen-shaped
box in the upper left corner of the window).

Hint 1: to view the image information on another image without having to close
the floating window and reopen it, simply click on another thumbnail.
Hint 2: none of the information in this dialog box may be changed because the
catalog is Read Only.
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Menus

This section of the Online Manual
describes the functions of the menu com-
mands.

File Menu
The File menu contains the commands for opening, closing,
printing, printer setup and exiting from the Kudo Reader.

Open (Ctrl+0)

To open another Kudo Catalog within the current Kudo Reader,
choose File—Open . This option displays the Open dialog box.
Select the CD-ROM drive and open the win_kudo directory.
Select one of the .kdb (Kudo Database files) listed and then
click on the OK button. The selected catalog opens in the same
screen as the current catalog. See the Window menu for addi-
tional screen display options.
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Close (Ctrl+W)

To close the currently selected catalog, choose File—Close. This option allows
you to save memory and close a catalog without exiting from the Kudo Catalog
Reader.

Print (Ctrl+P)

Use the standard Printer Setup and Print commands to print part or all of your cat-
alog. The Print feature always prints the current selection of thumbnails. For exam-
ple, to print all thumbnails in a catalog, choose Image—Find All to find every-
thing, then choose File—Print .

To print thumbnails with file name and size only, select the Gallery View prior to
printing your catalog. Printing a catalog in Small Gallery View prints the maximum
number of thumbnails per page.

To switch between views, click on the View button you prefer before printing a cat-
alog in the Gallery View, Small Gallery View or List View.
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Printer Setup

Printer Setup allows you to select available printers and change their options.

After choosing the menu command:

1. Select a printer and port from the Drop-down Combo box.

2. Click on the Setup button to open the Setup window and choose the print qual-
ity, paper orientation and size.

3. From the Setup window, click on
the Options button to choose
additional printer-specific options.

4. Click on the OK button on each
window to accept the changes.

Exit (Alt+F4)

The Exit command closes all open catalogs and then closes the Kudo Catalog
Reader.
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Edit Menu
The Edit menu contains one grayed-out, inaccessible command
called Copy Text. Copy Text is unavailable because all of the cata-
logs are Read Only. Only the Copy Thumbnail option is accessible.

Copy Thumbnail (Ctrl+C)

Copy Thumbnail copies the selected thumbnail in the currently active catalog to
the Clipboard viewer. Once an object has been copied to the clipboard, it is simple
to Paste the image into another application. Please note: The actual image, not
the thumbnail will be copied to the clipboard.

To retrieve the object from the clipboard, choose Edit—Paste from the menu of
the target application.
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View Menu
The View menu allows you to choose from three viewing options:
Gallery View, Small Gallery View and List View.

Note: The grayed out option is the active one.

Small Gallery (Ctrl+S)

The Small Gallery View uses the same layout as Gallery, but with much smaller
images, allowing the user to view more images at once. The filename will not be
displayed in this view. Click on the Info button to view detail about the selected
thumbnail. This command can also be activated by clicking on the Small Gallery
View button.

Gallery (Ctrl+G)

The Gallery View uses a grid-style layout showing several thumbnails and their file
type at once. This command can also be activated by clicking on the Gallery View
button.
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List View (Ctrl+L)

List View uses a vertical layout with fewer thumbnails in the window and a blank
notes section appears next to the thumbnail. The list view shows the thumbnails
in the first vertical column and the notes section in a second vertical column. This
command can also be activated by clicking on the List View button.

Please note: the information in the List View cannot be edited because the infor-
mation resides on the CD not on your hard drive. In other words, the catalog is
Read Only.
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Image Menu
The Image menu provides options on finding, pre-
viewing and getting information for your selected
thumbnail.

Display Original (Ctrl+E)

Kudo maintains a link between the thumbnail image in
the catalog and the original file. Use the Display Original option to preview the origi-
nal image file in a full-sized window.

1. Select the thumbnail you wish to preview.
2. Choose Image—Display Original .
3. Kudo finds the original image file and display it in a full-sized window.
4. Double-click on the Control menu box (the hyphen-shaped box in the upper left
corner of the window) to exit the preview window.
To preview other image files, simply click on their thumbnails while the Display
Original Image window is open.

Note: if the Find Image window appears, place the letter of your CD-ROM drive in
the text field and then press the return key.

8488pdf.qxd  4/2/96 3:58 PM  Page 29



Page 30

Get Info (Ctrl+L)

Get Info gives you quick access to a thumbnail's information. This option tells you
the filename, volume, size, date created, location and any notes attached to the
thumbnail. This option can also be
activated by clicking on the Info
button. Note: Usually, only the
name and size are distinct for each
thumbnail. This information cannot
be changed as it resides on the
CD, not on your hard drive. To dis-
play a thumbnail's information:

1. Select a thumbnail.
2. Choose Image–Get Info .
3. Kudo will display the information
in the floating window called Image
Information.
4. Double-click on the Control
Menu box (the hyphen-shaped box
in the upper left corner of the win-
dow) to exit the floating window.
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Find (Ctrl+F)

Use the Find feature to search the catalog for thumbnails with specific characteris-
tics. Kudo searches the catalog and displays the thumbnails that were identified in
the search. All other thumbnails are hidden from view.

When you select the Find button (or choose Image—Find ), Kudo displays the
Find Image dialog box.

1. Use the first combo box to tell Kudo which thumbnail characteristic it should
search.You can search by name, size, date modified, notes or location.

Note: a distinct find may not be available for all of the above characteristics.

2. Use the next combo box menu to tell Kudo how to search the catalog. The
selections in this combo box will become available after you make a selection
in the first combo box.

3. Use the Edit Text box to tell Kudo for which words or information to search. Wild
Card characters such as * or ? are not necessary. Enter or type text into this
box.

4. Click on the Find button.
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Find All (Ctrl+A)

Find All searches for and displays all thumbnails in the active catalog. This feature
is also used to restore all thumbnails after a Find operation. Find All is the equiva-
lent of executing a Find Everything by clicking on the Find button.

Sort Menu
The Sort menu allows you to sort thumbnails according to the following
criteria:

Name sorts by an eight character file name.
Size sorts by the actual image file size (bytes).
Kind sorts thumbnails alphabetically by their image type (extension).
Modification Date sorts by the date the image file was last modified.
Location sorts by the image file's location (pathname).
Notes sorts by the first word in the notes box.

To start a sort, simply choose one of the six commands in the menu and
the program will automatically start sorting the images in the order of the chosen
command. Note: only sorting by name and size produces a unique sort. In most of
our products, all other characteristics are identical for all images in the Kudo
Catalogs.
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Window Menu
The Window menu allows you to manipulate the currently displayed win-
dow with the following standard Windows options:

Cascade arranges open windows so that the title bar of each window is
visible
Tile arranges open windows side-by-side so that all of them are visible.
Arrange Icons arranges all program-item icons for a selected group into
rows.
Close All closes all open catalogs.
Document List lists the names of all currently open browsers.

Note: these options are only useful if you have more than one Kudo *.kdb
opened at one time. Click here to jump to the Open command in the File
menu for further information.
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Help Menu
The Help menu allows you to launch an online help file containing
instructions on how to use this program as well as credits for this pro-
gram.

Index launches Expert’s Online Help file.

Using Help launches the Windows Help on Help file.

About launches the Kudo Catalog Reader About box.
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Tutorial

Learn how to place the clip art images
while using Kudo. Tips for inserting the
images in various applications are also
covered in this section.

Placing Images Via Kudo
Through the Kudo Reader, users are able to preview the images as well as place
them into other applications. There are two methods for placing an image from a
Kudo Catalog into a document:

1. Copy and Paste
2. Drag and Drop
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Copy and Paste

1. Choose Edit—Copy Thumbnail to copy the selected thumbnail in the currently
active catalog to the Clipboard Viewer.
Note: once an object has been copied to the clipboard, it is simple to Paste the
image into another application. The actual image, not the thumbnail, is copied to
the clipboard.

2. To retrieve the object from the clipboard, choose Edit—Paste from the menu of
the target application.

Drag and Drop

Kudo takes advantage of Windows technology (DDE and OLE 2.0) which allows
you to Drag and Drop images into all popular graphics applications. When you
Drag and Drop from your Kudo catalog to an open document, Kudo will find the
original image file and place it in the document of selected desktop publishing and
other page layout applications, with pinpoint accuracy.
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To Drag and Drop a thumbnail to an open document:

1. Open the Target Document and open the Kudo Reader. Size both applications,
so that they can both be seen on the screen.

2. Select the thumbnail to be moved to the target document.

3. Hold down the mouse button and drag the image to the open document. The
cursor will change when you are able to drop it onto the document. If an "X"
appears on the cursor, you cannot drop the thumbnail onto the target docu-
ment.

The following applications support Drag and Drop:

• All graphics applications support Drag and Drop from the File Manager. This
includes virtually all leading applications.

• All graphics, desktop publishing, and multimedia applications that are OLE 2.0
clients. OLE 2.0 clients provide pinpoint accuracy when dropping onto a page
layout.

• Kudo includes Place Modules for the following applications that are not OLE
2.0 clients, but could benefit from Drag and Drop with pinpoint accuracy:

QuarkXPress® version 3.12. 3.2 and 3.3
Adobe® PageMaker® version 4.2 and 5.0
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Microsoft Word® version 2.0*
WordPerfect® 6.0

Note: for Microsoft Word users, Word will indicate that you can drop the image
only when the cursor is over the Word application toolbar or status bar (along
the bottom of the window). When the image is dropped, it will be inserted at
the exact location of the Word "I-beam" (insertion point). Release the mouse
button and Kudo will find the image and place it into the document.

Using the Images in Various Applications
The following programs are covered in this section: Aldus PageMaker, Harvard
Graphics, Microsoft Word, Word Pad, Write and WordPerfect. Please see the man-
ufacturers’ user guides for more detailed information on using the images with
other programs.

Microsoft ® Write (Windows ® 3.1)

1. Open or create a Write document.
2. Choose Edit–Insert Object .
3 Select Bitmap image in the Drop-down menu.
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If you have any questions, call Microsoft Windows support.

Microsoft ® Word Pad (Windows ® 95)

1. Open or create a Word Pad document.
2. Choose Insert–Object .
3. Select Bitmap image in the Drop-down menu.
If you have any questions, call Microsoft Windows support.

Microsoft ® Word ® 6.0 and 7.0

1. Open an existing Word document.
2. Choose Insert–Picture .
3. In the dialog box that appears, change the drive and directory to locate the
image. All of the images for the Kudo Catalogs are located on the Expert CD.
4. Select the image you want to use and click on the OK button.
5. Place the cursor anywhere on the document.
If you have any questions, call Microsoft Word support.

8487pdf.qxd  4/2/96 4:30 PM  Page 39



Page 40

QuarkXPress ® 3.1–3.3

1. Open an existing QuarkXPress document.
2. Select the desired picture box tool from the toolbox.
3. Create a picture frame by dragging and dropping the mouse in the desired size
and area of the page.
4. Choose File—Get Picture .
5. In the dialog box that appears, change the drive and directory to locate the
image. All of the images for the Kudo Catalogs are located on the Expert CD.
6. Select the image you want to use and click on the OK button.
7. Place the cursor anywhere on the document.
If you have any questions, call QuarkXPress technical support.

WordPerfect ® 6.0

1. Open an existing WordPerfect document.
2. Choose Graphic—Figure—Retrieve .
3. In the dialog box that appears, change the drive and directory to locate the
image. All of the images for the Kudo Catalogs are located on the Expert CD.
4. Select the image you want to use and click on the OK button.
5. Place the cursor anywhere on the document.
If you have any questions, call WordPerfect support.
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Adobe ® PageMaker ® for Windows

1. Open an existing PageMaker document or choose File—New .
2. Choose File—Place .
3. In the dialog box that appears, change the drive and directory to locate the
image. All of the images for the Kudo Catalogs are located on the Expert CD.
4.Select the image you want to use and click on the OK button.
5. Place the cursor anywhere on the document, then click.
If you have any questions, call PageMaker technical support.

Harvard Graphics ® for Windows

1. Create a Harvard Graphics presentation or open an existing presentation.
2. Choose File—Import.
3. In the dialog box that appears, choose a file format from the File Format drop-
down list.
4. Change the drive and directory to locate the Kudo Catalog image file category
on the CD.
5. Select the image you want and click on the OK button.
If you have any questions, call Harvard Graphics technical support.
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Frequently Asked Questions

This is a general section on possible situa-
tions that may arise while using the Kudo
Catalog Reader. Frequently asked user ques-
tions are also included.

Using a Kudo Catalog Reader 
Q: The thumbnails look poor in quality. What can I do to improve the way
they appear?

A: You probably are using a 8-bit video driver ( 256 colors ). Like viewing Apple
Quicktime movies or MS AVI movies, the more colors displayed, the smoother and
clearer the image will be. Set your video card for a higher color display 16-bits or
higher ( 32K, 64K, or 16.7M colors ). Changing video color modes requires you to
restart Windows. Don’t forget to save your work first.
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Q: When I double-click on a thumbnail, nothing happens or I get a "no
launch extension found for this file" message. What should I do? 

A: You do not have an application associated with this image or media type.
Windows 3.x and NT use the File Manager to set associations while Windows 95
uses the Explorer disk drive menus.

In Windows 3.x or NT, you will need to open File Manager. Then, choose File—
Associate . In the dialog box which appears, enter in a new extension (or modify
an old one) and assign it to an application.

In Windows 95, open the Explorer and choose the View—Options . In the Options
dialog box, select the File Types tab. Pick an image file type and click on the Edit
button to modify the application that is linked to this extension.

Note: please consult your Window’s operating system manuals for additional infor-
mation and help

Q: I am having problems printing my catalogs. What can I do?

A: You probably have an incompatible printer driver installed. Try to install a more
generic printer driver (a driver that has a larger printer group support - consult
your printer documentation). Kudo applications direct calls to standard Windows
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printer drivers. If you are using a laser printer, try using the HP LaserJet II printer
driver; most printers support it. For Dot Matrix printers, a common driver is the
Epson FX-80 or LQ-80.

Q: My thumbnail will not drag and drop into my application. What is happen-
ing?

A: In order to drag and drop thumbnails into other applications, the application
must be OLE 2.0 compliant. If the application you are trying to drag and drop into
is not OLE 2.0 compliant or Kudo does not have a Place Module for it, it may not
work. Many applications can still receive information via drag and drop, but may
only be able to access them through a specific location on the screen. This area is
the application Title bar ( i.e. Microsoft Word, Corel DRAW!, Pagemaker, etc. ) at
the top of the program.You can tell that you are allowed to drop a thumbnail onto
an application when the cursor turns into a box with an arrow.

Q: Nothing happens when I drag and drop a thumbnail into a PageMaker or
QuarkXPress document. What am I doing wrong?

A: When an image type is not supported by the target application, the application
tends to ignore it (or do other unpleasant things; i.e. you can drag and drop into
Excel, but Excel will try to open the image file as a worksheet and it will fill all the
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data cells with junk). Check the kind of thumbnail you are using; it must be an
image type supported by the version of Pagemaker or QuarkXPress you have
installed on your computer.

Q: Why are there grayed-out commands?

A: The Kudo Catalog Reader provided on the CD is a Read Only version of Kudo
Publisher. It only contains those commands needed for using the catalog reader.

Q: Why doesn’t the Kudo Catalog Reader save any of the text changes I
made?

A: The Kudo Catalog Reader provided on the CD is a Read Only version of Kudo
Publisher. It only contains those commands needed for using the catalog reader.

Q: What should I do when I get the Find Image dialog box after choosing
Image—Display Original?

A: Place the letter of your CD-ROM drive in the text field and then press the Enter
key. This dialog appears when the Kudo Catalog Reader is not sure where the
original CD images are located.
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Q: Are there any shortcuts for the menu commands?

A: The following list contains all Keyboard Short Cuts for the program.

File Men u
Open Ctrl+O

Close Ctrl+W

Print Ctrl+P

Exit Alt+F4

Edit Men u
Copy Thumbnail Ctrl+C

View Menu
Small Gallery Ctrl+S

Gallery Ctrl+G

List Ctrl+L
Image Menu
Display Original Ctrl+E

Get Info Ctrl+I
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Find Ctrl+F

Find All Ctrl+A

Help Men u
Index F1
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About
Adobe PageMaker for

Windows
Arrange Icons
Cascade
Close
Close All
Copy and Paste
Copy Thumbnail
Copyrights and

Trademarks
Credits
Display Original
Document List
Drag and Drop
Edit Menu
Exit
File Menu
Find

Find All
Find Button
Frequently Asked

Questions
Gallery View
Gallery View Button
Get Info
Harvard Graphics for 

Windows
Help Menu
Image Information
Index
Info Button
Installing TrueType Fonts 

in Microsoft Windows
3.1

Installing TrueType Fonts
in Microsoft Windows 95
Kind

Kudo Catalog Reader
License Statement
List View
List View Button
Location Notes
Menu Bar
Microsoft Word 6.0 and 

7.0
Microsoft Word Pad
Microsoft Write
Modification Date
Name
Print
Printer Setup
Printing Catalogs
Product Support 
QuarkXPress 3.1-3.3
Riffle Feature
Shortcuts

Size
Small Gallery View
Small Gallery View

Button
Sort Menu
Status Bar
Thumbnail
Thumbnails Gallery
Tile
Tutorial
Using Help
Using Kudo Catalog 

Reader
Using the Images in 

Various Applications
View Menu
Window Menu
WordPerfect 6.0

Index
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Expert Software License Statement 
This software is protected by both United States Copyright Law and International Treaty provisions. Expert Software, Inc. grants you this license and your
continued use confirms your agreement. Therefore, you must treat the software “just like a book,” with the following single exception: Expert Software,
Inc. authorizes you to make archival copies of the software for the sole purpose of backing up your software and protecting your investment from loss.
By saying “just like a book,” Expert Software, Inc. means, for example, that the software may be used by any number of people and may be freely moved
from one computer to another, so long as there is no possibility of being used at one location while it’s being used in another. This is just like a book that
cannot be read by two different people in two different places at the same time; neither can this software be used by two different people in two different
places at the same time.
This agreement shall be construed, interpreted, and governed by the laws of the state of Florida and shall inure to the benefit of Expert Software, Inc. its
successors, administrators, heirs, and assigns. 
Limited Warranty
Limited warranty on product disks. To the original buyer only, Expert Software, Inc. warrants the disk or disks on which this product is recorded to be free
of defects in material and workmanship under normal use for a period of 90 days from the purchase date. Any implied warranties of merchantability or fit-
ness for a particular purpose are limited in duration to the period of 90 days from the date of purchase. Your sole and exclusive remedy in the event of a
defect in material or workmanship under normal use is expressly limited to replacement of the defective item.
This warranty gives you specific legal rights, and you might also have other rights which vary from state to state.
No warranty on product software or User’s Guide. Even though Expert Software, Inc. has tested the software and User’s Guide and reviewed their con-
tents, Expert Software, Inc. and its distributors and dealers make no warranties, either expressed or implied, with respect to the fitness for a particular
purpose. The software and User’s Guide are distributed solely on an as is basis. The entire risk as to their quality and performance is with you. Should
either the software or User’s Guide or both prove defective, you (and not Expert Software, Inc. and its distributors and dealers) assume the entire cost of
all necessary servicing, repair, or correction. Expert Software, Inc. and its distributors and dealer will not be liable for direct, indirect, incidental, or con-
sequential damages resulting from any defects in the software or User’s Guide, even if they have been advised of the possibility of such damages.
Some states do not allow limitations on how long an implied warranty lasts or the exclusion or limitation of incidental or consequential damages, so the
above limitations or exclusions might not apply to you.
Copyright
© 1996 Expert Software, Inc. All Rights Reserved.  All Rights Reserved Worldwide. The user’s guide and the software described in it are copyrighted with
all rights reserved. The user’s guide or software may not be copied in whole or part, without written consent of Expert Software, Inc. You may not sell,
rent, lease or transfer copies of the user’s guide or software in any other way without the prior written consent of Expert Software, Inc.
Trademarks
Expert Software and the Expert brand logo are trademarks of Expert Software, Inc. Microsoft and Windows are registered trademarks of Microsoft Corp.
Macintosh is a registered trademark of Apple Computer Inc. All other trademarks are acknowledged.
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Expert Product Support Policy
Your purchase of an Expert product includes free product support to help you get the most out of your software. All Expert products are thoroughly test-
ed and come with a user’s guide and/or help file. In most cases, the answer to many of your questions are in this guide and/or the help file.
If you are having problems starting or running the program, please feel free to give us a call. We can be reached at (305) 567-9996, Monday through
Friday, 9:00AM to 5:00PM EST (Eastern Standard Time).
When you call, you should be at your computer. Be ready to give the Product Support Specialist the 10-digit program version number from the front of
your program disk or back of the CD jewel case, as well as the following information:
If you have a Macintosh–compatible computer:
• Please have the model, system software version and amount of memory available.
If you have Windows– or MS-DOS–compatible computer:
• The version of DOS that is installed on your computer. (You can determine the version by typing VER at the DOS prompt.)
• The version of Windows® installed on your computer.
• The type of hardware you are using:

1. The brand of computer you own, 
2. CPU type (80386, 80486, Pentium), 
3. Video type (EGA, VGA, Super VGA),
4. Model and type of video card, and 
5. Model and type of printer.

• The exact wording of any messages that appeared on the screen.
• What happened and what you were doing when the problem occurred.
• We encourage Windows® (or MS-DOS 6.x) users who need product support to print an MSD report. Have it available for the Product Support Specialist

who answers your call. You will find the MSD (Microsoft Diagnostics) program in either the Windows or the DOS directory.
In case of defective disks
If the disk or disks should fail within 90 days of purchase, please return the original disk with proof of purchase for FREE replacement. After 90 days
from date of purchase, please include $9.50 for replacement. You can obtain a replacement disk of the program by returning the defective copy, and
your proof of purchase to Expert Software, Inc. Attention: Customer Service, P.O. Box 144506, Coral Gables, FL 3114-4506.
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Copyright © 1996 AT&T CORP. All rights reserved. AT&T WORLDNETSM SERVICE is a
service mark of AT&T. Microsoft, Windows, and Windows 95 are trademarks of
Microsoft Corporation. Netscape, Netscape Navigator, and the Netscape Navigator
Included logo are trademarks of Netscape Communications Corp. 

Information in this booklet is current as of 5/17/96 and is subject to change. Your use of
the AT&T WORLDNETSM SERVICE software is subject to the Netscape Navigator end-user
license agreement included in the software. Your use of AT&T WORLDNETSM SERVICE is
subject to the AT&T WORLDNETSM SERVICE Agreement, which is available for review
during the registration process and within the Customer Service section of the AT&T
WORLDNETSM SERVICE web site, as that agreement may be modified by AT&T from time to
time.

Your Expert Software user registration codes are:

For AT&T Long Distance Subscribers enter....17MQFM631

For AT&T Non-Subscribers ............................17MQFM632
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Questions? Call 1 800 400-1447
We’re here to help you, 24 hours a day, 7 days a week.
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Welcome!
Thanks for choosing AT&T WORLDNETSM Service — an exciting
new world of opportunity, fun, and excitement.

Brought to you by the global leader in communications and net-
working, AT&T WORLDNETSM Service delivers everything you need
to make the most of the wealth of experiences you can find on the
World Wide Web. Just follow the simple instructions in this booklet,
and soon you’ll be exploring the Internet as a registered AT&T
WORLDNETSM Service member.

About your computer system

Make sure your system meets these minimum requirements:

• IBM compatible 386SX computer (486 recommended)
• 8 MB of RAM (or more for better performance)
• 11 MB of available hard disk space
• VGA card and monitor capable of displaying 256 colors
• 14,400 bps modem connected to an outside phone line
• Microsoft® Windows 95 

Windows 95 note: If Dial-Up Networking is not installed, have
your Windows 95 CD-ROM or disks handy (see page 32).

ÿ
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About AT&T WorldNetSM Service

To register, you must provide the following information:

• Your registration code (printed on the address label)

• Your credit card number (MasterCard®, VISA®, or
American Express® card; charges will appear monthly on
your statement)

• An E-mail ID and password of your choice (so you can
send and receive electronic mail)

• A security word of your choice (to verify your identity if
you update your account information)

During registration, you must select a pricing plan. Hourly and unlimit-
ed usage access options are available. After you become a member, you
may change your pricing plan by updating your account online, send-
ing an electronic mail message to 
wnetbill@attmail.com, or contacting AT&T Customer Care at 
1 800 400-1447.

Finally, you must select an access telephone number (the number
your modem dials for access to AT&T WORLDNETSM SERVICE). For a
complete list of numbers, see page 24.
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Installing the AT&T WorldNet
SM

Service software

First, make sure your modem is ready to go — that is, it should be
turned on (if external) and configured for Windows 95. Make sure
Windows 95 is running, and close all open applications and folders, includ-
ing Dial-Up Networking, on the desktop and taskbar. 

CD ROM installation: Insert your AT&T WORLDNETSM SERVICE CD-
ROM disk. Software installation will begin automatically.

Floppy disk installation: Insert the AT&T WORLDNETSM SERVICE

software (Disk 1 of 3) in your drive. Click the Start button on the
Windows 95 desktop (see next page). Click Run, then type a:\setup
(or change the “a” to a different letter if the software is in another
drive). Click OK to begin software installation.

If Dial-Up Networking is not installed, you will be asked if you want
to install it. We recommend that you install it now. To install it later,
see page 32.

If you need assistance during installation, see the If You Need More
Help section beginning on page 30 for solutions to problems like
these:

• If Windows 95 is not configured for your modem, see page 30.

• If Netscape Navigator 2.0 software is already installed on your
computer, see page 35.
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If you’re already an AT&T WORLDNETSM SERVICE member:

If you’re upgrading from an earlier version of AT&T WORLDNETSM

SERVICE software, do not install the new software in the same folder.
Use the default instead (c:\Program Files\WorldNet).

After you run Setup, see page 36 for instructions on how to complete
your upgrade quickly.
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Double-click this icon to begin.
When the first Account Setup
screen appears, click Next to 
continue.

Setting up your account

After the software is installed, several icons are displayed in your new
folder. To set up your account, double click the account setup icon as
shown below. If you see the message “You must log on to your PC
before registering,” see page 34.

At the second screen, select the “create account”
option, then click the Next button to continue.

To set up your account you must answer a series of questions about
you, your credit card preference, your modem type, and your phone.

At the “Modem Information” screen, click Next if a modem name is
displayed in the box. If the box is empty, or if the wrong modem is
displayed, please turn to page 30 for help.
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Fill in the blanks on each screen,
then click the Next button to contin-
ue as you complete each screen.

Click Next after you complete each page. Click Finish on the last
page to transmit your member information to AT&T using a private,
toll-free number. Your information is kept strictly confidential.
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Completing your registration

The last step in registration is to review and complete the informa-
tion you entered while setting up your account. If the system finds
an error, the screen is redisplayed with a STOP sign to show where
you must enter the correct information.

Enter the 9-character registration code printed
on the address label of your AT&T
WORLDNETSM SERVICE software package

Registration Code Information

Enter your registration code as printed on the top of the address label

on your AT&T WorldNetSM Service Kit. If you do not have a registration
code, please call the AT&T Customer Care Center on 1 800 400-1447.

Registration Code:

During registration you must choose an Account Information securi-
ty word, an E-mail ID, and an E-mail password.

If you enter an E-mail ID that is already in use, you’ll be asked to
enter another one. You can use any form of your name. For example,
you might use your initials, or spell out your middle name, to make
it unique.
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You can record your E-mail information below for future reference. Do
not disclose your password, your security word, or your account informa-
tion to anyone.

Your E-mail ID ________________________________________
(cannot contain spaces or any special characters except hyphens or peri-
ods)

Your E-mail password __________________________________
(this word is case sensitive; that is, “PassWord” is not the same as “pass-
word”)

Click Continue after you review each page. Click Finish at the last
page to complete your registration. Afterward, be sure to restart
Windows 95 when prompted so your computer is configured proper-
ly to run the software.

This is a good time to back up your account information. See page
39 for further information.

Please note: If you are disconnected during registration, select the
Double Click to Set Up Account icon, or symbol, to start over. At the
opening screen, choose the I need to create an AT&T WorldNetSM

Service account option.
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Browsing the Internet

Congratulations! As a new member of the AT&T WORLDNETSM Service,
you’re ready to explore the wide world of the Internet.

After you’ve completed registration, you can gain access to the
Internet at any time by double-clicking the AT&T WORLDNETSM

Service icon on your desktop or in the AT&T WORLDNETSM Service
folder.

AT&T
WorldNet
Service

DO NOT CHANGE
your user name 
or password.

Click Connect
to begin
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Hyperlinks can be easily identified because your mouse
cursor changes (usually to a hand icon) when passed
over any linked word or graphic image.

After a moment, you’ll see the AT&T WORLDNETSM Service home
page on the World Wide Web (WWW). The simplest way to begin
browsing the Internet is to start here, and begin clicking on hyper-
links to explore your options. 

Hyperlinks are special words or graphics in a document that contain
the address of another document. By clicking on these hyperlinks,
you can explore many thousands of sites, services, and information
sources across the country and throughout the world.

WONET20.QXD  7/17/96 8:13 PM  Page 13



14

How to get help and advice

Before you begin exploring the Internet, you might want to take a
moment to check two useful sources of information.

If you’re new to the Internet, click on the New Users hyperlink for a
quick explanation of unfamiliar terms and useful advice about
exploring the Internet.

The Help menu contains detailed information that may be of use
even to more experienced users of the Internet.

If you need help with installation, registration, or use of the software,
check the Troubleshooting Guide in the AT&T WORLDNETSM
SERVICE folder (see page 30).

Note: You must click Disconnect to end your 
connection to AT&T WORLDNETSM Service (see page 38).
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Help menu

• About AT&T W ORLDNETSM Service :
Shows software version information.

• Netscape Navigator Handbook : A
guide to AT&T WORLDNETSM SERVICE

software.

• Where to Get More Help : Takes you
directly to AT&T WORLDNETSM SERVICE

Member Services for technical sup-
port and online help with account,
billing, and child safety concerns.

New Users Click Here

New to the Internet? Click
here for a quick description of
the Internet and tips to make
browsing easier.
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Using your AT&T WorldNet
SM

Service
software

The AT&T WORLDNETSM SERVICE software makes
Internet browsing fast and simple. For a more
detailed description of these and other program fea-
tures, click the Help menu and select Netscape
Navigator Handbook.

To create more room for Internet pages, you can
make your document window larger by “hiding”
the Toolbar and Directory buttons if you don’t
often use them. Click the Options menu to display
a list of features you can show or hide.

TIP: While browsing Internet documents,
click your right mouse button for quick
access to many frequently used features.

It’s easy to get lost in the worldwide maze of the
Internet. No matter where you are, you can always
start over by clicking Home to return to AT&T
WORLDNETSM Service.

http://www.worldnet.att.net/

WONET20.QXD  7/17/96 8:14 PM  Page 16



17

The Bookmarks menu
is a directory you can
customize to find your
favorite places quickly
(see page 18).

For quick access to AT&T
Customer Service, click
Help, then select Where to
Get More Help.

Click here to check for new
E-mail, or to send a mes-
sage to someone else (see
page 20).

The status line shows the Internet
address (URL) of any hyperlink as
you pass your mouse cursor over a
page displayed in your document
window.

http://www.worldnet.att.net/

Click the Directories
button for a list of
Internet resource, 
personal, and business
directories.
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Bookmarks make browsing easy

Bookmarks allow you to keep track of your favorite Internet sites, so
you can return to them whenever you want. Click on the Bookmarks
menu to see a list of sample sites. You can go directly to a site by
clicking on any item in the list.

As you browse the Internet, you can add sites to the list by clicking
Bookmarks | Add Bookmark (or just press Ctrl+A on your keyboard).
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Click Bookmarks | View Bookmarks (or press Ctrl+B) to open a new
window showing all bookmarks. You can use the File, Edit, and Item
menus to customize your list, by adding or moving categories or spe-
cific sites.

Double-click any cate-
gory to show or hide
its contents.
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Sending and receiving E-mail

On AT&T WORLDNETSM Service, you can exchange E-mail with
anyone in the world who has access to the Internet. To send or
receive mail, select Window | AT&T WorldNetSM Service Mail (or
click the E-mail icon at the lower right edge of your screen).

To receive messages, you should let others know your E-mail address.
Your address is your E-mail ID followed by 
@worldnet.att.net. For example, the address of a person using the ID
“pjones” would be: pjones@worldnet.att.net.

TIP: To check quickly for new mail, click on
the envelope icon, at the lower right edge of
your screen.
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Using Netnews

Netnews works like a global bulletin board, where people all over the
world can post, read, and respond to messages organized by topic, or
newsgroup.

Click the Newsgroups button to begin using Netnews. The News
window will display a sample list of newsgroups. You can view more
by clicking Options | Show All Newsgroups. To subscribe to any news-
group, click the check box next to the group name.

Click on any newsgroup to see the list of messages it contains. You can
reply to any message by clicking the Message menu, or submit a mes-
sage of your own by clicking the File menu.

Click here to open your Newsgroups window
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Access telephone numbers

During registration, the AT&T WORLDNETSM SERVICE software sug-
gests an access telephone number for you. If you prefer to use a 
different one, you can use any number listed here.

If you have selected one of your local phone company’s calling plans,
you may want to ask them whether the access number you select is
covered by the plan.

If none of the numbers listed here are acceptable, ask your local tele-
phone company about optional calling plans in your area that may
allow you to use one of the numbers listed here at a reduced rate.

Otherwise, you can use the number 1 800 543-3279 for an additional
charge of $4.50 per hour (about 8 cents per minute). This number can be
convenient to use when you’re away from home.

To change your access telephone number, right-click your AT&T
WORLDNETSM SERVICE connection in the Dial-Up Networking folder.
Select Properties, enter the number where indicated, then click OK.

Questions? Call 1 800 400-1447
We’re here to help you, 24 hours a day, 7 days a week.
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Alabama

Birmingham ..........205 327-6520
Huntsville ..............205 518-2140
Mobile ....................334 441-9370
Montgomery ..........334 223-5140

Arizona

Phoenix ..................602 340-9248
Tucson ..................520 770-9006

Arkansas

Little Rock ..............501 372-0104

California

Bakersfield ............805 633-3630
Fresno....................209 497-7822
Gardena ................310 767-5950
Hayward ................510 581-0270
Long Beach ..........310 429-7493
Los Angeles ..........213 955-5409
Modesto ................209 491-3150
Ontario ..................909 983-8604
Oxnard ..................805 487-7344
Palm Springs ........619 320-9426
Redwood City ........415 562-2400
Sacramento ..........916 498-3020
Salinas ..................408 771-1150
San Bernardino ....909 884-7604
San Diego..............619 220-6920
San Francisco........415 296-1275
San Jose................408 494-0910
Santa Ana ..............714 444-9327

Santa Barbara........805 564-1115
Van Nuys ..............818 986-0462
Stockton ................209 939-3089

Colorado

Colorado Springs ..719 444-0216
Denver ..................303 572-0522

Connecticut

Bridgeport..............203 696-3940
Danbury ................203 207-5430
Hartford..................860 244-8200
New Haven ............203 777-1942
New London ..........860 442-9324
Stamford ................203 975-2908

Florida

Daytona Beach......904 257-5990
Fort Myers..............941 277-7171
Fort Lauderdale ....954 316-1500
Gainesville ............352 337-6885
Jacksonville ..........904 798-3300
Miami ....................305 375-7600
Ocala......................352 690-3059
Orlando..................407 245-7802
Panama City ..........904 913-3400
Pensacola ..............904 470-0800
Sarasota ................941 365-5700
Tallahassee ............904 224-2223
Tampa ....................813 621-1178
West Palm Beach ..407 803-4672
Winter Haven ........941 295-9500
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Georgia

Albany....................912 430-8900
Atlanta....................404 221-3620
Augusta..................706 821-8700
Columbus ..............706 321-2070
Macon....................912 765-4200
Savannah ..............912 651-6000

Hawaii

Honolulu ................808 536-8495

Idaho

Boise......................208 344-1009

Illinois

Champaign ............217 352-0679
Chicago ................312 441-0661
Peoria ....................309 673-8611
Rockford ................815 966-1001
Springfield ............217 525-6199

Indiana

Bloomington ..........812 334-1115
Evansville ..............812 424-0104
Fort Wayne ............219 422-3476
Indianapolis ..........317 237-0039
South Bend............219 239-7125

Iowa

Cedar Rapids ........319 362-1910
Davenport ..............319 322-9333
Des Moines............515 288-2810

Kansas

Topeka ..................913 235-1491
Wichita ..................316 264-1712

Kentucky

Lexington ..............606 252-3031
Louisville ................502 562-0830

Louisiana

Baton Rouge..........504 336-8400
Lafayette ................318 289-1009
New Orleans ..........504 561-7860
Shreveport ............318 675-3000

Maine

Portland ................207 879-9650

Maryland

Baltimore................410 783-4570
Monrovia ................301 865-0717

Access telephone numbers (continued)
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Massachusetts

Cambridge ............617 621-3400
Lawrence ..............508 557-0299
Springfield ............413 263-6630
Worcester ..............508 751-4900

Michigan

Detroit ....................313 964-3100
Grand Rapids ........616 776-2601
Kalamazoo ............616 226-9408
Lansing ..................517 484-7994
Saginaw ................517 753-6166

Minnesota

Minneapolis ..........612 339-0328
Rochester ..............507 286-1047

Mississippi

Gulfport ..................601 867-9078
Jackson ................601 360-2000

Missouri

Kansas City............816 221-4569
Springfield ............417 866-1239
St. Louis ................314 534-6483

Montana

Billings ..................406 245-1399
Great Falls ............406 771-7718

Nebraska

Omaha ..................402 341-6863

Nevada

Las Vegas ..............702 386-8056
Reno ......................702 334-4400

New Hampshire

Manchester ............603 627-0300

New Jersey

Asbury Park ..........908 493-3030
Fanwood................908 322-2288
Carteret ..................908 541-2600
Freehold ................908 866-0347
Middletown ............908 615-0112
Morristown ............201 292-9557
New Brunswick......908 418-0357
Newark ..................201 623-1292
Passaic ..................201 458-8484
Pleasantville ..........609 383-0315
Princeton................609 275-0955
Ridgewood ............201 251-8561
Rochelle Park ........201 291-0121
Trenton ..................609 581-8100

New Mexico

Albuquerque ..........505 242-7070
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New York

Albany....................518 447-0459
Binghamton ..........607 724-9070
Buffalo....................716 853-0820
New York................212 528-2420
Plainview................516 249-2948
Poughkeepsie........914 452-0038
Rochester ..............716 454-1030
Syracuse................315 448-4575
White Plains ..........914 397-2300

North Carolina

Asheville ................704 232-5200
Charlotte ................704 376-2060
Fayetteville ............910 678-2036
Greensboro............910 412-5880
Raleigh ..................919 508-3000
Wilmington ............910 350-8800

North Dakota

Fargo......................701 232-4658

Ohio

Akron ....................330 374-1400
Canton ..................330 588-2273
Cincinnati ..............513 665-9909
Cleveland ..............216 622-7566
Columbus ..............614 221-8831
Dayton ..................513 449-1444
Mansfield ..............419 522-2308
Toledo ....................419 243-0147
Youngstown ..........330 744-7981

Oklahoma

Oklahoma City ......405 270-0039
Tulsa ......................918 582-0129

Oregon

Eugene ..................541 686-0449
Portland ................503 221-2174
Salem ....................503 362-0785

Pennsylvania

Erie ........................814 454-6182
Harrisburg..............717 236-5884
Philadelphia ..........215 772-1560
Pittsburgh ..............412 391-6163
Scranton ................717 348-4060
York ........................717 843-9008

Puerto Rico

San Juan................787 725-9622

Rhode Island

Providence ............401 453-9360

South Carolina

Charleston ............803 720-4240
Columbia ..............803 988-7420
Greenville ..............864 282-0400
Myrtle Beach..........803 626-3834

Access telephone numbers (continued)
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South Dakota

Sioux Falls ............605 336-3437

Tennessee

Chattanooga..........423 757-8800
Johnson City..........423 282-5304
Knoxville ................423 521-0100
Memphis ................901 543-5400
Nashville ................615 401-7570

Texas

Abilene ..................915 676-0273
Austin ....................512 708-0200
Beaumont ..............409 838-1988
Brownsville ............210 546-0121
Corpus Christi........512 883-0280
Dallas ....................214 826-4651
El Paso ..................915 577-0400
Fort Worth..............817 338-1047
Houston ................713 759-6839
Longview ..............903 753-6390
Lubbock ................806 749-0397
Midland ..................915 683-5510
San Angelo ............915 653-0126
San Antonio ..........210 225-0742
Waco......................817 752-4994

Utah

Salt Lake................801 322-5758

Vermont

Burlington ..............802 865-2750

Virginia

Arlington ................703 685-8700
Lynchburg..............804 847-0262
Norfolk ..................804 626-3835
Richmond ..............804 771-5440
Roanoke ................540 342-9185

Washington

Kennewick ............509 735-4400
Olympia ................360 709-2460
Seattle....................206 382-0108
Spokane ................509 456-0421
Tacoma ..................206 272-3982

West Virginia

Charleston ............304 340-8066

Wisconsin

Appleton ................414 831-4920
Madison ................608 282-7944
Milwaukee..............414 223-5112

Wyoming

Cheyenne ..............307 632-0673
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If you need more help

Click the Troubleshooting Guide icon in the AT&T
WORLDNETSM SERVICE folder for helpful tips and
advice about installation, registration, and use of the
software. In the Troubleshooting Guide, you’ll find

complete answers to questions and problems like the ones described
in this section.

Configuring Windows 95 to work with 
your modem

1 Click Start on the Windows 95 taskbar.

2 Select Settings, then click Control Panel.

3 Double-click Modems.

4 If your modem is listed under the “General” tab, it has been con-
figured to work properly. If not, click Add, then follow the
instructions on screen.

Questions? Call 1 800 400-1447
We’re here to help you, 24 hours a day, 7 days a week.

Troubleshooting
Guide
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Click any topic for
more detailed
information
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Installing Windows 95 Dial-Up Networking

You’ll need your Windows 95 CD-ROM or disks to install Dial-Up
Networking.

1 Click Start on the Windows 95 taskbar.

2 Select Settings, then click Control Panel.

3 Double-click Add/Remove Programs.

4 Click the Windows Setup tab.

5 Select Communications (but do not click the check box next to
it). Click the Details button.

6 Select the Dial-Up Networking check box, then click OK.

7 On the Windows Setup tab, click OK. When prompted, insert
your Windows 95 CD-ROM (or disks) to begin software installa-
tion.

Note: Do not restart Windows 95 until you have added the TCP/IP
protocol (see next page).

If you need more help (continued)
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After Dial-Up Networking is installed, follow these steps to add the
TCP/IP protocol:

1 Click Start on the Windows 95 taskbar.

2 Select Settings, then click Control Panel.

3 Double-click Network.

4 On the Configuration tab, click Add.

5 Double-click Protocol.

6 Select Microsoft from the “Manufacturers” column. Select
TCP/IP from the “Network Protocols” column.

7 Click OK. Windows 95 will then install the appropriate software.

8 When prompted, restart Windows 95. You will be prompted to
enter a user name and password. Do not click Cancel. Enter your
name and an optional password. If you choose not to enter a
password, you will be logged in to Windows 95 automatically
whenever your computer is restarted. Click OK to continue.
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Logging onto Windows 95

When you set up your account, you may see this message:

“When using the Internet, Windows 95 requires users to log on to
their computers. If you have a logon, please restart the computer and
enter it.”

This message means that you are not logged on to Windows 95. To log
on, follow these steps:

1 Click Start on the Windows 95 taskbar.

2 Select Shut Down...

3 Select the option “Close all programs and log on as a different
user.” (If this option does not appear, consult the How-to section
of the Troubleshooting Guide, under the heading “How to install
the client for Microsoft Networks.”)

4 Click the Yes button.

Windows 95 will restart, and you will be prompted to enter a user
name and password. Do not click Cancel. Enter your name and an
optional password. If you choose not to enter a password, you will be
logged in to Windows 95 automatically whenever your computer is
restarted. Click OK to continue.

If you need more help (continued)
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Netscape Navigator 2.0 software is already installed

Please note that special care must be taken if you want to maintain
both AT&T WORLDNETSM SERVICE software and another copy of
Netscape Navigator 2.0 on the same computer.

Do not install AT&T WORLDNETSM SERVICE software in the same
folder as your Netscape Navigator software. The default folder select-
ed during Setup is recommended (c:\Program Files\WorldNet).

After installation, click the Troubleshooting Guide icon in the AT&T
WORLDNETSM SERVICE Services folder to learn which Windows 95
settings are shared between AT&T WORLDNETSM SERVICE and
Netscape Navigator 2.0 software, and to learn how to maintain them.
This information can be found in the Special Cases section of the
guide, under the heading “When You Have More Than One
Installation of Netscape Navigator Software 2.0.”
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Upgrading from an earlier version of AT&T WORLDNETSM

SERVICE software

If you’ve installed an earlier version of AT&T WORLDNETSM SERVICE

software, follow these steps to upgrade your software quickly:

1 Double-click the Double Click to Set Up Account icon in your
AT&T WorldNetSM Service folder.

2 Click Next on the opening screen.

3 At the “Updating Your Dialing Information” screen, select Yes,
then click Next.

4 At the “Modem Information” screen, make sure that the correct
modem is displayed, then click Next. If no modem (or the wrong
modem) is displayed, select Cancel. If you are asked to restart
Windows, select Restart Later. Follow the instructions on page
30 to configure Windows 95 for your modem, then return to
step 1 on this page.

5 At the “Exploring the Internet” screen, click Finish to complete
your software upgrade.

When prompted, restart Windows 95 to configure your system prop-
erly. Keep your E-mail password handy, since you will have to re-
enter it the first time you use E-mail services with your new software.

If you need more help (continued)
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Dial-Up Networking has lost my password

Follow these steps if you see the error message: “Unable to connect to remote
computer. Check your password and then try again.”

1 Double-click the Shortcut to AT&T WorldNetSM Service icon to
display your user name (similar to 123456789@worldnet.att.net)
and password (***************).

2 Open the AT&T WorldNetSM Service folder and double-click on
the Troubleshooting Guide icon.

3 Click Table of Contents, then click How To.

4 Click Backup your AT&T WorldNetSM Service account informa-
tion and follow the instructions on screen. Select Account
Summary Only.

5 Check the Connect To window to make sure the “User Name” field
contains the same information as the “Network login name” infor-
mation in your account summary.

6 Copy the contents of the “Network password” field (in your
account summary) to the password field of the Connect To win-
dow.

7 Make sure there is a check mark in the “Save Password” box.

8 Click Connect for access to AT&T WORLDNETSM Service. (Note
that Windows 95 will not save your password until you have used
it to log on to the service.)
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Telephone line does not disconnect 
automatically after exiting from the AT&T WORLDNET

SM

SERVICE software

Closing the AT&T WORLDNETSM Service software does not automat-
ically disconnect you from the Internet.

To close the connection, click Connected to AT&T WorldNetSM Service
on your Windows 95 taskbar, which opens a connection status win-
dow. Click Disconnect to close the connection and hang up your
phone line.

If your connection is idle for 20 minutes, the software will ask you if
you want to disconnect from the Internet. To change this time inter-
val:

1 Click your right mouse button on the AT&T WorldNetSM Service
icon (on the Windows 95 desktop).

2 Select Properties.

3 To turn the automatic disconnect feature on or off, click the Auto
Disconnect check box.

4 When the automatic disconnect feature is on, enter the time
interval you prefer. The software will disconnect from the
Internet after the period of inactivity you select.

If you need more help (continued)
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Backing up or moving your account 
information to another PC

Complete instructions on how to back up your account 
information, or move it to another PC, can be found in the
Troubleshooting Guide. To review this information:

1 Double-click the Troubleshooting Guide icon in your AT&T
WorldNetSM Service folder.

2 Click Table of Contents.

3 Click How-to.

4 Click Back up your AT&T WorldNetSM Service account infor-
mation.

Note: An AT&T WORLDNETSM Service account may be used on
more than one PC only under specific conditions. Click Terms and
Conditions on the AT&T WORLDNETSM Service home page to see a
copy of your service agreement.

Questions? Call 1 800 400-1447
We’re here to help you, 24 hours a day, 7 days a week.
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Windows 3.x Users:
Before you begin

Typically, you will need 30 minutes to install, register and log on to

your AT&T WorldNetSM Service account. Should you require assis-

tance at any point in the process, call AT&T WorldNetSM Service
Customer Care at 1 800 400-1447.

Installation tips

When installing the software, please follow the instructions for set-
up. At the end of installation, your computer will restart. Don’t forget
to click on “RESTART WINDOWS” because you will not be able to reg-
ister until you have done this.

Once you’ve installed the CD-ROM, the software will “call” AT&T
to register you as a new customer. If you experience a modem problem,
try selecting Hayes Compatible. If this does not work, call customer care
at 1 800 400-1447.

During the registration process you will be asked to:

• Choose a special “security code” that you will use to verify who you
are when you call customer care.

• Tell us whether you are an AT&T Long Distance Service customer
so that you can receive the 5 free hours a month usage plan.

• Choose an e-mail address identification that will be your “name”
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on the Net.

• Choose an e-mail password that you will use to create your AT&T

WorldNetSM Service account.

System Requirements

To run AT&T WorldNetSM Service you need:

• An IBM-compatible personal computer 

• 80386X processor (or better) Microsoft® Windows® 3.1X or
Windows 95

• 8MB RAM and 11MB of free hard disk space

• 14.4 bps (or faster) modem and a phone line not connected to a
Local Area Network (LAN)

Getting Started

To Install AT&T WorldNetSM Service, simply:

• Turn on your computer and modem, start Windows, and close all
other applications, Microsoft OfficeTM.

• Insert Disk 1 into your floppy disk drive (A or B)

• From the Program Manager, choose File/Run

• Type A:\setup (or B:\setup)
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• Choose OK

• Follow the instructions on your screen to register for AT&T

WorldNetSM Service. (During registration, you will be prompted to
enter a valid MasterCard, Visa, or American Express Card number.

Please read through the AT&T WorldNetSM Service terms and con-
ditions before you register.

Be sure to check for error messages. In order for your account infor-
mation to be accepted, you must enter the information fully and cor-
rectly.

If you make a mistake and exit the registration process prematurely,
all you need to do is click on “Create New Account.” Do not click
on “Edit Existing Account.”

Complete all three stages of registration. A check mark will be dis-
played next to each stage when you have successfully completed it.

When choosing your AT&T WorldNetSM Service access telephone
number, you will be given several options. Please choose the one
nearest to you.

© 1996 AT&T All Rights Reserved. AT&T WorldNetSM Service is a service mark of AT&T
corp. Netscape Navigator logos, Netscape Navigator, and Netscape are trademarks of Netscape
Communications Corporation.
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à

WorldNet
Service
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